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Thank you for purchasing the AP9945 Portable Bit Error Rate Tester (BERT).  
This user’s manual explains the functions and operating procedures of the AP9945. To 
ensure correct use, please read this manual thoroughly before beginning operation. 
After reading this manual, keep it in a convenient location for quick reference in the 
event a question arises during operation.  

Notes 
•  The contents of this manual are subject to change without prior notice as a result of 

continuing improvements to the instrument's performance and functions. Display 
contents illustrated in this manual may differ slightly from what actually appears on 
your screen.  

•  Every effort has been made in the preparation of this manual to ensure the accuracy 
of its contents. However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.  

•  Copying or reproducing all or any part of the contents of this manual without the 
permission of Yokogawa Electric Corporation is strictly prohibited. 

Trademarks 
•  Windows and Windows XP are either trademarks or registered trademarks of 

Microsoft Corporation in the United States and/or other countries.  
•  Adobe, Acrobat, and Acrobat Reader are either trademarks or registered trademarks 

of Adobe Systems in the United States and/or other countries.  
•  The company and product names used in this manual are not accompanied by the 

trademark or registered trademark symbols (TM and ®).  
•  Other company and product names are trademarks or registered trademarks of their 

respective companies.  
Revisions 

• 1st Edition November, 2004 
• 2nd Edition January, 2006 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2nd Edition : January 2006 (YK) 
All Rights Reserved, Copyright © 2004 Yokogawa Electric Corporation 
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Terms and Conditions of the Software 
 
 
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software Program 
(hereinafter called the “Licensed Software”) to the Licensee on the conditions that the Licensee agrees to the terms and conditions stipulated in Article 
1 hereof.  
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called the 
“Agreement”) based on the use intended for the Licensed Software.   
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event shall 
Yokogawa intend to sell or transfer the Licensed Software to the Licensee. 
 
Licensed Software Name: AP9945 portable BERT Software 
Number of License:  1 
 
Article 1 (Scope Covered by these Terms and Conditions) 
1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the 

Licensee consents to agree to the terms and conditions stipulated herein. 
1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary technology, 

algorithms, and know-how such as a factor, invariant or process contained therein. 
 
Article 2 (Grant of License) 
2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the 

license fee separately agreed upon by both parties.   
2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the 

Licensed Software. 
2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes.  The Licensee shall secure 

or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.  
2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may 

translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed Software.  
Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed Software.  

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which grants 
Yokogawa the rights.  In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the Licensed 
Software. 

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software.  In no event shall the Licensee remove or attempt to remove such 
copy protection. 

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which may 
include any software program from affiliates of Yokogawa made or coded by themselves.)  In the case that Yokogawa is granted permission to 
sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions than those 
stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in writing separately. 

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, 
including any copy thereof. 

 
Article 3 (Restriction of Specific Use) 
3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for the 

purpose of the following events: 
a) Operation of any aviation, vessel, or support of those operations from the ground;, 
b) Operation of nuclear products and/or facilities;, 
c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or 
d) Operation of medical instrumentation directly utilized for humankind or the human body. 

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility 
for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, to 
solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, 
damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims arising out of and 
related to the above-said claims and damages. 

 
Article 4 (Warranty) 
4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered.  If defect(s), such as 

damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed 
Software on condition that the defective Licensed Software shall be returned to Yokogawa’s specified authorized service facility within seven (7) 
days after opening the Package at the Licensee’s expense.  As the Licensed Software is provided to the Licensee on an “as is” basis when 
delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation, data on computer 
programs and program listings, be completely accurate, correct, reliable, or the most updated.  

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms and 
conditions that apply shall be those established by the provider of the third party software.  

4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision 
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”). 

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted 
renovation or improvement of the Licensed Software. 

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE, 
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD 
PARTY SOFTWARE TO YOKOGAWA. 

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any 
failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the 
Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in warranty, 
contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or arising out of 
the use of the Licensed Software. 

 
Article 5 (Infringement) 
5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under 

patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed Software, 
the Licensee shall notify Yokogawa in writing to that effect without delay. 

 



Terms and Conditions of the Software License 

IM 734001-01E                                                                 iii 

 
5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate with 

the claiming party.  Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s 
defense and negotiation.  If and when such a claim should be attributable to Yokogawa, subject to the written notice to Yokogawa stated in the 
preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s cost and expense and be 
responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1. 

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s 
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at 
Yokogawa’s cost and expense. 

a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use the 
Licensed Software; 

b) To replace the Licensed Software with an alternative one which avoids the infringement; or 
c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right. 
5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa shall 

indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee.  THE 
FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY 
SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT 
LIMITED TO, PATENT AND COPYRIGHT. 

 
Article 6 (Liabilities) 
6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided to 

the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this 
Agreement.  However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage, 
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue, loss 
of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s business, 
substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of Licensee or other 
third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the extent of 
this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee which 
Yokogawa has received.  Please note that Yokogawa shall be released or discharged from part or all of the liability under this Agreement if the 
Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic specifications or functional 
specifications, without Yokogawa’s prior written consent. 

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless 
Yokogawa is notified of the claim within one (1) year of its occurrence. 

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between 
the Licensee and its customers. 

 
Article 7 (Limit of Export) 
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other than 
those where Yokogawa permits export in advance. 
 
Article 8 (Term) 
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until 
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice to 
the Licensee. 
 
Article 9 (Injunction for Use) 
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems that 
the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other condition 
which Yokogawa may not permit. 
 
Article 10 (Termination) 
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to 
perform this Agreement.  However, Articles 5, 6, and 11 shall survive even after the termination. 
 
Article 11 (Jurisdiction) 
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably 
through negotiation between the parties upon the basis of mutual trust.  Should the parties fail to agree within ninety (90) days after notice from one of 
the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main office) in Japan for 
settlement of the dispute. 
 
Article 12 (Governing Law) 
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely and 
irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the Licensee’s 
local law. 
 
Article 13 (Severability) 
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null 
and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect. 
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Checking the Contents of the Package 
 
 

Unpack the box and check the contents before operating the instrument. If any of the 
contents are incorrect, missing, or appear to be abnormal, please contact your 
YOKOGAWA dealer or representative.  
 

AP9945 Main Unit 
Check that the model and suffix code on the name plate on the side panel of the 
instrument match those of your order.  
 
 
 
 
 
 
 
 
●  Models and Suffix Codes 

Model SUFFIX Specifications 
734001  AP9945 Portable BERT 
SG -SG0 

-SG1 
No SG (oscillator required) 
SG built in 

Oscillator 1    -F10 
   -F11 
   -F12 
   -F13 
   -F14 
   -F15 

No oscillator 1 (when SG built in) 
Oscillator 1 frequency: 9.95328 GHz 
Oscillator 1 frequency: 10.3125 GHz 
Oscillator 1 frequency: 10.6642 GHz 
Oscillator 1 frequency: 10.709 GHz 
Oscillator 1 frequency: 11.095 GHz 

Oscillator 2       -F20 
 
      -F22 
      -F23 
      -F24 
      -F25 

No oscillator 2 (when SG built in, or with only 
oscillator 1) 
Oscillator 2 frequency: 10.3125 GHz 
Oscillator 2 frequency: 10.6642 GHz 
Oscillator 2 frequency: 10.709 GHz 
Oscillator 2 frequency: 11.095 GHz 

Power cord           -E 
 
 
          -G 
 
 
          -J 
 
 
          -U 

VDE standard power cord  
 Maximum rated voltage: 250 VAC 
 Maximum rated current: 10 A 
AS standard power cord  
 Maximum rated voltage: 250 VAC 
 Maximum rated current: 6 A 
BS standard power cord  
 Maximum rated voltage: 250 VAC 
 Maximum rated current: 5 A 
UL/CSA standard power cord  
 Maximum rated voltage: 125 VAC 
 Maximum rated current: 10 A 

 
Suffix Code Example 

• When one oscillator (10.3125 GHz) is selected, with VDE power cord:  
 734001-SG0-F12-F20-E 
• When two oscillators (10.3125 GHz and 11.095 GHz) are selected, with AS power 

cord: 734001-SG0-F12-F25-G 
• When the built-in SG type is selected, with UL/CSA power cord: 
 734001-SG1-F10-F20-U 

 
● NO. (Instrument number) 
 Please have the instrument number (NO.) ready when contacting your dealer or 
 representative. 

 

MODEL

SUFFIX

NO.

Made in J a p a n
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Accessories 
The standard accessories below are supplied with the instrument. 

Accessory Name Q’ty Remarks 
Power cord 1 The power cord selected from the following is 

included.  
 VDE standard power cord  
 AS standard power cord  
 BS standard power cord  
 UL/CSA standard power cord  

USB cable 1  
Terminators 6 Attached to the main unit 3.5 mm-Female: 2 

SMA-Female: 4 
Protective caps 5 Attached to the main unit 
Rubber feet 1 2 pcs. per set, separated before use 
Software CD 1 CD (part number: M3938MA): 

 AP9945 PORTABLE BERT Software 
User's manual 1 AP9945 Portable BERT User’s Manual (this manual)

 :IM734001-01E 
 
   Power cord     USB cable     Terminators: 6   Protective caps: 5 
 
 
 
 
 
 
 
   Rubber feet   Software CD   U
     (M3938MA) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 3.5 mm： SMA：

 2 pc. 4 pc. 
                        v 

ser’s manual 
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Safety Precautions 
 
 

This instrument is equivalent to an IEC standard safety class I device (with protective 
grounding terminal). To ensure safe and correct operation of the instrument, you must 
take the safety precautions given below. The instrument’s protective functions may not 
work if used in a manner not described in this manual. Yokogawa Electric Corporation 
bears no responsibility for, nor implies any warranty against damages occurring as a 
result of failure to take these precautions.  
 

The following safety symbols and wording is used in this manual.  
 

Warning: Handle with care. Refer to the user’s manual or service manual. This 
symbol appears on dangerous locations on the instrument which require special 
instructions for proper handling or use. The same symbol appears in the 
corresponding place in the manual to identify those instructions.  
 
Alternating current 
 
 
ON (power) 
 
 
OFF (power) 
 
 
Stand-by 
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The following precautions must be taken to prevent potentially fatal accidents.   
 

  
 

●  
 
 
 

● 
 
 
 
 

● 
 
 
 
 

● 
 
 
 

● 
 
 

● 
 
 

● 
 
 

Use the Correct Power Supply 
Before connecting the power cord, ensure that the power supply source voltage 
matches the rated supply voltage of the instrument and that it is within the 
maximum rated voltage of the provided power cord.  
Use the Correct AC Power Cord and Adapter 
To prevent the possibility of electric shock or fire, be sure to use the power cord 
supplied by YOKOGAWA. The main power plug must be plugged into an outlet 
with a protective earth terminal. Do not invalidate this protection by using an 
extension cord without protective earth grounding.  
Use Protective Grounding  
Make sure to connect the protective earth to prevent electric shock before 
turning ON the power to the instrument. The power cord that comes with the 
instrument is a three-prong power cord. Therefore the power cord should be 
connected to a properly grounded three-prong outlet.  
Never Disable Protective Grounding 
Never disable the instrument’s internal or external protective earth wire or 
disconnect the wiring of the protective earth terminal. Doing so poses a 
potential shock hazard.  
Never Use If You Suspect Protective Functions Are Defective 
Do not operate the instrument if the protective earth or fuse might be defective. 
Always check these before operation.  
Do Not Use Near Flammable Gases 
Never use the instrument in locations with flammable or explosive gases or 
vapors. Doing so is extremely dangerous.  
Do Not Remove the Case 
Only qualified Yokogawa technicians may remove the case. Certain parts of the 
instrument carry high voltages, and are dangerous.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WARNING
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Conventions Used in This Manual 
 
 

Safety Markings 
The following markings are used in this manual.  
 

Improper handling or use can lead to injury to the user or damage to 
the instrument. This symbol appears on the instrument to indicate 
that the user must refer to the user's manual for special instructions. 
The same symbol appears in the corresponding place in the user's 
manual to identify those instructions. In the manual, the symbol is 
used in conjunction with the word “WARNING” or “CAUTION.”  

 
Calls attention to actions or conditions that could cause serious or 
fatal injury to the user, and precautions that can be taken to prevent 
such occurrences.  

 
Calls attentions to actions or conditions that could cause light injury 
to the user or damage to the instrument or user's data, and 
precautions that can be taken to prevent such occurrences.  

 
Calls attention to information that is important for proper operation of 
the instrument.  

 
Notations Used in the Procedural Explanations 

On pages that describe the operating procedures in chapters 3 through 4, the following 
notations are used to distinguish the procedure from their explanations.  
 

This subsection contains the operating procedure used to carry out 
the function described in the current section. The procedures are 
written with inexperienced users in mind; experienced users may not 
need to carry out all the steps.  

 
This subsection describes the setup parameters and the limitations 
on the procedures. It may not give a detailed explanation of the 
function. For a detailed explanation of the function, see chapter 2.  

 
Notation of User Controls 
•  Soft button:  xxx button  (Ex.) Click the OK button.  
•  Parameters:     (Ex.) Select TRAFFIC.  
•  Switch:  xxx switch   (Ex.) Press the power switch.  
•  Hard key: xxx key   (Ex.) Press a cursor key.  
•  Menu:  YYY > ZZZ (menu)   (Ex.) Choose File > Login in the menu.  

 
Units 

k Denotes 1000. Example: 10 kHz, 10 kg 
K Denotes 1024. Example: 100 KB 
M Denotes 1000000 when the units are bps or Hz. Example: 100 Mbps, 10 MHz 

Denotes 1048576 when the units are bytes. Example: 100 MB  
G Denotes 1000000000 when the units are bps or Hz. Example: 10 Gbps, 10 GHz 
 
 

WARNING 

CAUTION 

Note 

Procedure 

Explanation 
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111.1 Product Overview 
 
 

The AP9945 is a 10 Gbit/s band bit error rate tester. It comprises a PPG*1 section for pattern 
generation, and an ED*2 section for error measurement, enabling BER measurement in a 
single unit.  
 
*1 Pulse pattern generator   
*2 Error detector  

 
Main Features and Functions 

● The AP9945 contains a PPG and ED in a single unit, allowing 10 Gbit/s band bit error 
testing.  

● It supports multi bit rate patterns (built in SG type).  
Bit rate: 9.95 to 11.32 Gbit/s 1 kbit/s steps 

● For the PPG output, the amplitude, offset, and cross point can be changed. 
• Data output amplitude: 0.50 to 2.00 Vp-p 
• Data offset: -2.00 to 3.00 V 
• Data cross point: 30 to 70 % 

● CDR is built-into the ED. The bit error test can be performed without wiring of the 
clock signal. 

● The receive threshold level of the data signal input to the ED can be changed.  
● The AP9945 can generate low bit rate patterns (PPG): 

1/2 (5 Gbit/s band), 1/4 (2.5 Gbit/s band), and 1/8 (1.25 Gbit/s band) 
● The unit is lightweight, compact, and highly portable.  
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1.2 Front Panel, Rear Panel, Top Panel 
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(2) OUTPUT switch 

(3) S

(5) DATA OUT terminal 

(6) CLOCK OUT terminal 
(7) CLOCK OUT terminal 

(10) TRIGGER OUT terminal 
(14) TRIGGER OUT terminal 

(12) DATA IN terminal 

(13) 10G CLOCK IN terminal 
(8) REF CLOCK IN (1/16,1/64) terminal 
(1) Power switc
          

wer switch (PO
hen the rear pa
n be used to tur

UTPUT switch ->
witch for turning

atus display LED
Name In
POWER  

STANDBY  

OUTPUT OU

TA OUT termin
 non-inverted da
e output is turne
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n inverted data o
 turned ON.  

OCK OUT term
 10 GHz non-in
ock signal is out

tatus display LED 

(4) DATA OUT terminal (11) DATA IN(CDR) terminal 
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WER) -> section 3.4 
nel main power switch is ON (in power standby mode), this switch 
n the power ON and OFF.  

 section 3.4 
 the PPG output ON and OFF.  

 -> section 3.4 
dication Illumination/Blinking  

Illuminated when the power is ON.  
When the power switch and main power switch are 
turned ON.  
Illuminates when in power standby mode.  
When main power switch ON and power switch OFF. 

TPUT Illuminates when PPG output is ON.  
When the OUTPUT switch is turned ON.  

al 
ta output terminal. Non-inverted data of 10 Gbit/s is output when 
d ON.  

al 
utput terminal. Inverted data of 10 Gbit/s is output when the output 

inal 
verted clock signal output terminal. A non-inverted 10 GHz-band 
put when the output is turned ON.  

(9) 10G CLOCK IN terminal 
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(7) CLOCK OUT terminal 

A 10 GHz inverted clock signal output terminal. An inverted 10 GHz-band clock 
signal is output when the output is turned ON.  

 
(8) REF CLOCK IN (1/16, 1/64) terminal 

An external synchronization signal input terminal. A reference signal with a 
frequency 1/16 or 1/64 of the 10 Gbit/s rate is input when the PPG signal is 
generated and synchronized with an external clock signal, without use of the 
instrument’s oscillator or SG. This clock is used not only for the PPG, but also for the 
reference clock signal to operate the CDR function of the ED. 

 
(9) 10G CLOCK IN terminal 

An external clock signal input terminal. A 10 Gbit/s rate clock is input when the unit is 
operated using an external 10 Gbit/s rate clock signal without use of the instrument’s 
oscillator or SG. This clock is used not only for the PPG, but also for the reference 
clock signal to operate the CDR function of the ED. 
 

(10) TRIGGER OUT terminal 
An output terminal for the PPG trigger signal. A trigger signal selected from the 
following is output. 
• Clock trigger (1/16 or 1/64) 

Outputs a clock signal that is 1/16 or 1/64 of the PPG clock rate.  
• Pattern trigger 

Outputs a trigger signal synchronized to the pattern of the PPG.  
• Low bit trigger 

Outputs a clock frequency signal interlocked with a low bit rate pattern.  
 

(11) DATA IN (CDR) terminal 
An ED data input terminal with a CDR function. Used when measuring with the CDR 
function. Since the clock is regenerated from the received data, the clock input is not 
needed.  
 

(12) DATA IN terminal 
An ED data input terminal. Used for measuring with the clock signal (10G CLOCK 
IN) synchronized to the data.  
 

(13) 10G CLOCK IN terminal 
An ED clock signal input terminal. When using the DATA IN terminal, input a clock 
signal synchronized to the data. Adjust the phase with an external phase shifter or 
other device so that the relationship between the data and clock phase is such that 
the data conversion point matches up with the falling of the clock.  
 

(14) TRIGGER OUT terminal 
Trigger signal output terminal of the ED. A trigger signal selected from the following 
is output. 
• Clock trigger (1/16 or 1/64) 

Outputs a clock signal that is 1/16 or 1/64 of the input data rate of the ED.  
• Pattern trigger 

Outputs a trigger signal synchronized to the input pattern of the ED.  
 
Note 

 For input/output terminal connections for (4) to (14), see section 3.8.  
 

 
 



1.2  Front Panel, Rear Panel, Top Panel  

1-4                                                         

Rear Panel 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(1) Main power switch -> section 3.4 

Turns the power ON and OFF. When OFF, all power sup
standby power.  
 

(2) Power connector -> section 3.3 
Connects the power supply. Connector with a prot
Connect the accessory power cord.  
 

(3) Fuse holder -> section 5.4  
Fuse holder for the power fuse.  
 

(4) USB Port -> section 3.6 
Connects to a controller PC using the accessory USB ca
 

(5) Fan 
An exhaust fan.  
 

(6) EXT IF connector 
A connector for testing. Do not use it for connecting ext
can lead to malfunction. 
 

Top Panel 
 
 
 
 
 
 
 
 
 
 
 
 
 
(1) Air inlet 

Ventilation holes. Air inlets are also located on the under
 

(2) Handle -> sections 3.1, 3.2 
Use when carrying or placing the instrument.  

USB

EXT I/F

100-240V
MAIN POWER

AC 100VA MAX 50/60Hz
FUSE 250V T 4A

 

(1) Main
(2) Power connector

(3) Fuse holder 
(4) USB port 
(5) Fan 
(6) EXT IF connector 
plies are OFF including the 

ective grounding terminal. 

ble 

ernal instruments. Doing so 

 power switch 
(1) Ventillation holes 
(2) Handle 
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2.1 Function Block  
 
 

Block Diagram 
The following is a block diagram of the AP9945.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Block Explanation 
● SG (Signal Generator)/X'tal: Clock Generator 

In this circuit block, a highly accurate clock is generated based on the internal quartz 
oscillator. With the crystal type, the clock generator outputs the oscillator clock. With 
the SG type, you can change the frequency according to the bit rate setting.  

 
● PPG (Pulse Pattern Generator) 

In this circuit block, PRBS* and program patterns are generated. Additionally, the 
offset can be changed in the AMP of the CLOCK OUT. The amplitude, offset, and 
cross point can be changed in the AMP of the DATA OUT.  

 
● ED (Error Detector) 

In this circuit block, the bit error is detected from the PRBS pattern* and program 
pattern, and then counted. The bit error count results are sent to the controller PC 
via the USB cable in real-time.  
* Pseudo random bit sequence pattern  

Pattern

Generator

REFERENCE
 CLOCK IN
(1/16,1/64)

DATA OUT

DATA OUT

CLOCK OUT

CLOCK OUT

TRIGGER OUT

DATA IN

10G CLOCK IN

DATA IN(CDR)

TRIGGER OUT

Controler IO Read / Write

SW

POWER

Inlet

USB

to each circuit

Error
Detector

Power
Suply

10G CLOCK IN

SG/X'tal

Controller PC 
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2.2 Data Logic Inverting Function 
= For details about operation, see section 4.2 = 

 
Data Logic Inverting Function 

This instrument is equipped with a data logic inverting function that inverts the logic of 
the data output signal of the PPG and the data input signal of the ED.  

 
Polarity Normal: Positive logic 
  Invert: Negative logic 

 
Note 

 The Normal/Invert logic is inverted at the data invert output terminal.  
 

Data Logic 
Data logic is as follows.  
 
● DATA OUT terminal 
 
 
 
 
 
 
 
 
 
● DATA OUT terminal 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Normal

H

L

“1”

“0”

Invert

H

L

“0”

“1”

Normal

H

L

“0”

“1”

Invert

H

L

“1”

“0”
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2.3 Output Change Function 
= For details about operation, see section 4.5 = 

 
With this instrument, the outputs of the Data Amplitude, Data Offset, Data Cross Point, Bit 
Rate, and Clock Offset can be changed. The output change function allows testing 
corresponding to the interface conditions for the DUT. Additionally, the performance 
evaluation and other tests of the DUT can be performed by changing the output level.  
 

Data Amplitude 
The amplitude of the data (DATA OUT/DATA OUT terminal) can be changed. 
• Data Amplitude :  0.50 to 2.00 [Vp-p], in steps of 0.01 [Vp-p] 
 
 
 
 
 
 

Data Offset/Clock Offset 
The DC offset voltage of the data (DATA OUT/DATA OUT terminal)/clock (CLOCK 
OUT/CLOCK OUT terminal) can be changed. For the DC offset voltage, the average value of 
the output level becomes the reference level. 
• Data Offset/Clock Offset :  -2.00 to 2.00 [V], in steps of 0.01 [V] 
 
 
 
 
 
 
The amplitude in case of Clock Offset is fixed at approximately 0.6 [Vp-p].  

Data Cross Point 
The cross point of the H/L level of the data can be changed. 
• Data Cross Point: 30 to 70 [%], in steps of 1 [%] 

 

Data Offset
 -2.00 to 3.00V

Data Amplitude
0.50 to 2.00Vp-p

Data Amplitude
0.50 to 2.00Vp-p
●  DATA OUT terminal 
E                                  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A cross point signal in which the Data
is output to the DATA OUT terminal.  
The cross point shows the value 
Sucoflex104 (L=0.7m). 
 

Data Cross Point
30%

Data Cross Point
50%

Data Cross Point
70%
● DATA OUT terminal 
                              2-3 

 Cross Point setting value is subtracted from 100% 

at the end of the recommended coaxial cable 

Data Cross Point
50%

Data Cross Point
30%

Data Cross Point
70%
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Bit Rate 
With the built in SG type, the bit rate of the internal SG can be changed.  
• Bit Rate :  9.950000 to 11.320000 [Gbit/s], in steps of 0.000001 [Gbit/s] 
 
 
 
 
 
 
 
 
 
 

Bit Rate
9.95 to 11.32Gbit/s
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2.4 Threshold Level Change Function 
= For details about operation, see section 4.3 = 

 
This instrument allows you to adjust the threshold of DATA IN (CDR) or DATA IN to an 
optimal level. As you adjust the threshold while measuring the bit error, you can find the 
points both in the positive and negative directions at which an error occurs. The 
threshold can be set to an optimal level by setting the threshold value at the center of 
the range where no error occurs. 
 
(1) Adjustment when the received signal level is low 

When the received signal level is low, an error may occur. Even so, you may remove 
the error by adjusting the threshold level. 

 
(2) Adjustment when the upper and lower waveforms are not symmetrical. 

When the mark ratio is not 50%, the center of the amplitude may not be an optimal 
threshold. Even though the upper and lower waveforms are not symmetrical, you 
may remove the error by adjusting the threshold level. 
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2.5 CDR Function 
= For details about operation, see section 4.3 = 

 
CDR Function 

Clock & Data Recovery 
This CDR function recovers the clock from the received data signal and adjusts the 
timing of the data. 
 
Since the CDR function is built in, the instrument can perform the BER measurement 
without connection of the clock.  
 

Example of Connection with the DUT 
The following shows an example of connection between the instrument and the DUT 
using the CDR function.  
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POWER

REF CLOCK IN
(1/16,1/64)
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CLOCK IN10G
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0.6Vp-p

DATA OUT

0.5Vp-p 2.0Vp-p 0.5Vp-p 2.0Vp-p

GENERATOR

CLOCK OUT

0.6Vp-p

DATA OUT

TRIGGER OUT

0.6Vp-p

ERROR DETECTOR
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1.0Vp-p MAX

DATA IN (CDR)

0.7Vp-p MAX

TRIGGER OUT

0.6Vp-p

DATA IN

0.6Vp-p MAX

ALL PORTS

 

DATA OUT DATA IN (CDR)

DATA OUT 
DATA IN
                  

DUT 
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2.6 Trigger Output Function 
= For details about operation, see section 4.3 = 

 
Types of Triggers 

The instrument provides a trigger output function. You can select one of each trigger signal 
for the PPG and the ED.  
 
(1) Clock trigger: PPG1/16, PPG1/64, ED1/16, ED1/64 

Outputs a clock signal that is 1/16 or 1/64 of the PPG send clock rate or the ED 
receive clock rate.  
 

(2) Pattern trigger: PPG Pattern, ED Pattern 
Outputs a trigger signal that is synchronized with the send pattern of the PPG or the 
receive pattern of the ED.  
●  PRBS pattern:  

Outputs 128 bits of a positive pulse signal at intervals 128 times the PRBS 
pattern. 

●  Program pattern:  
Repeatedly outputs a positive pulse signal and negative pulse signal 1024 bits in 
width.  

 
(3) Low bit rate trigger: 1/1 (PPG only) 

When the Divide Ratio is 1/2, 1/4, or 1/8, a clock signal synchronized to 1/2, 1/4, or 
1/8 of the specified rate is output.  

 
Applications of Triggers 

(1) Clock and pattern triggers used for waveform observation.  
The trigger can be used as the trigger signal when observing a 10 Gbit/s waveform 
with a super-high frequency sampling oscilloscope.  

 
(2) Clock trigger used as the frequency dividing clock signal for measurement of optical 
 transceivers.  

For optical transceivers or other devices, when a frequency 1/16 or 1/64 of 10 Gbit/s 
is input as the reference clock, the 10Gbit/s-clock signal is generated. When 
measuring the optical transceiver, such frequency dividing clock signals may be 
required. 

 
(3) Clock trigger used as a reference clock to synchronize multiple module units.  

The trigger is used as a clock signal for synchronization of multiple units.  
 
(4) Low bit rate trigger used as a trigger signal for observation of low bit rate patterns.  

Can be used as a trigger signal for waveform observation of low bit rate patterns (1/2, 
1/4, 1/8).  
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Trigger Waveforms 
  (1) Clock trigger 
 
 
 
 
 
 
 
 
 
 
 
  (2) Pattern trigger 
    ●  PRBS pattern 
 
 
 
 
 
 
 
 
 
 
 
    ●  Program pattern  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

128 1 2 3 127 128 1 2 3
DATA OUT
DATA IN

(PRBS pattern)
・・・・・・・・・・・ 126

PPG Pattern TRG
ED Pattern TRG

Positive pulse
for 128 bits

128 cycles of PRBS pattern

One cycle of PRBS pattern

Positive pulse
for 128 bits

1 2 3 ・・・・・・・・・・・

Positive pulse
for 128 bits

PPG Pattern TRG
ED Pattern TRG

DATA OUT
DATA IN

(Program pattern)

One cycle of Program pattern

54

・・・・・・・・・・・

Negative pulse
for 128 bits

 01 02 03 04 05 06 07 08 09 10  11 12 13 14 15 16 17 18 19 20  21 22 23 24 25 26 27 28 29 30  31 32 33 34 35 36 37 38 39 40

CLOCK

TX1/16 TRG
RX1/16 TRG

TX1/64 TRG
RX1/64 TRG
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  (3) Low bit rate trigger 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*: Data synchronized to a low bit rate trigger is output on the DATA OUT terminal.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PPG1/1 TRG
(Divide Ratio=1/2)

CLOCK

PPG1/1 TRG
(Divide Ratio=1/4)

PPG1/1 TRG
(Divide Ratio=1/8)

DATA

DATA OUT
(Divide Ratio=1/2)

DATA OUT
(Divide Ratio=1/4)

DATA OUT
(Divide Ratio=1/8)
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Connection Examples 
(1) Used as trigger signal for observation of waveforms.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 *1: If the DUT needs a C
 *2: With the phase shifte
 
 
(2) Used as a reference clock for a
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3.1 Handling Precautions 
 
 

Safety Precautions 
● Safety Precautions 

If you are using this instrument for the first time, make sure to thoroughly read the 
safety precautions given on pages vi and vii.  

 
● Do Not Remove Covers  

Do not remove the case. The instrument's internal components carry high voltages 
and are extremely dangerous. For internal inspection or adjustment, contact your 
nearest YOKOGAWA dealer.  

 
● In Case of Abnormality 

If there are any symptoms of trouble such as strange smells or smoke coming from 
the instrument, turn the main power OFF immediately, and remove the power cord 
from the outlet. If such an irregularity occurs, contact your YOKOGAWA dealer.  

 
● Handle the Power Cord Correctly 

Nothing should be placed on top of the power cord. The power cord should also be 
kept away from any heat sources. When unplugging the power cord from the outlet, 
never pull by the cord itself. Always hold and pull by the plug. If any of the contents 
listed on page v are incorrect, missing, or appear to be abnormal, please contact 
your YOKOGAWA dealer or representative.  
 

General Handling Precautions 
● Do Not Place Anything on Top of the Instrument 

Never place other instruments or objects containing water on top of the instrument. 
Doing so can lead to malfunction. 

 
● Do Not Apply Shock or Vibration  

Do not apply shock or vibration to the instrument. Doing so can lead to malfunction. 
Also, if shock is applied to the signal input/output terminals or connection cables, 
signals modified by electrical noise may be input or output.  

 
● Do Not Bring Charged Objects Near the Instrument  

Do not bring charged objects near the input terminals. Doing so can damage the 
internal circuitry. 

 
● Unplug During Periods of Extended Non-Use 

Disconnect the power to the instrument, and remove the power cord from the outlet.  
 
● Take Proper Care When Carrying the Instrument 

First, disconnect the power to the instrument, then remove the power cord and 
connection cables. When carrying the instrument, always hold by the handle with 
two hands as shown in the figure below.  
 
 
 
 
 
 
 

● Clean the Instrument Properly 
When removing dirt from the case or unit, disconnect the power to the instrument, 
remove the power cord from the power outlet, then wipe gently with a clean, dry 
cloth. Do not use volatile chemicals since this might cause discoloring and 
deformation.  
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3.2 Installing the Instrument 
 
 

Install the Instrument under the Proper Conditions 
Install the instrument only in indoor locations that meet the following conditions.  
 
● Flat, Horizontal Surface 

Place the instrument in the correct orientation, and in a stable location that is 
horizontal in all directions.  

 
● Well Ventilated Locations  

Ventilation holes are present on the top and bottom of the instrument, and an 
exhaust fan is located on the back of the instrument. To prevent internal overheating, 
do not obstruct the vent holes or the exhaust fan.  

 
● Ambient Temperature and Humidity 

Ambient temperature: 5 to 40°C  
Ambient humidity: 20 to 80%RH 
Note that no condensation can be present.  

 
● Do Not Install the Instrument in the Following Places 

•  In direct sunlight or near heat sources. 
•  Where an excessive amount of soot, steam, dust, or corrosive gas is present. 
•  Near strong magnetic field sources. 
•  Near high voltage equipment or power lines. 
•  Where the level of mechanical vibration is high. 
•  In an unstable place. 

 
Note 

 Condensation may occur if the instrument is moved to another place where the 
ambient temperature is higher, or if the temperature changes rapidly. In this 
case, let the instrument adjust to the new temperature for at least an hour, and 
ensure that no condensation is present before using the instrument.  

 
Orientation 

● Desktop 
Install the instrument in a flat, horizontal location as shown in the figure below. When 
installing the instrument with the handle turned upward, make sure that the handle is 
securely fastened. Pull the handle out approximately 2 to 3 mm to the left and right 
of the handle rotation axis, then slowly rotate the handle to the stop position.  

 
Handle Stop Position 
It is recommended to use the instrument with the handle in the 1, 3, 5, or 8 stop 
position. When using the instrument in the 2 or 4 stop position, do not place any 
objects on top of the instrument.  
 
 
 
 
 
 
 
 
 

 
Note 

 When the ins
together. Whe
will not knock 

1
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Pull the left and right sides of the 
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3.3 Connecting the Power Supply 
 
 

Before Connecting the Power 
Heed the following warnings to avoid electric shock or damage to instruments.  

 

  
 

●  
 

●  
 

●  
●  

 
 

● 
  

●  
 
 

Check that the supply voltage matches the instrument’s rated power supply 
voltage before connecting the power cord.  
Check that the instrument’s main power switch is OFF before connecting the 
power cord.  
To prevent shock or fires, only use the power cord supplied by YOKOGAWA.  
Make sure to perform protective earth grounding to prevent electric shock. 
Connect the instrument’s power cord into a three-prong electrical outlet with a 
protective grounding terminal.  
Do not use an extension cord without protective earth ground. Otherwise, the 
protection function will be compromised. 
Use an outlet that is compatible with the accessory power cord, and be sure to 
connect protective grounding. Do not use the instrument if the power outlet does 
not provide appropriate protective grounding.  

 
Connecting the Power Cord 

1. Check that the main power switch on the rear panel is OFF.  
2. Connect the accessory power cord plug to the power connector on the rear panel.  
3. Connect the plug at other end of the cord to a power outlet that satisfies the 

conditions below. The AC outlet must be of a three-prong type with a protective earth 
ground terminal.  

Item Specifications 
Rated supply voltage 100 to 240 VAC 
Allowed supply voltage fluctuation range 90 to 264 VAC 
Rated supply voltage frequency 50/60 Hz 
Power supply frequency variation range 48 to 63 Hz 
Maximum power consumption 100 VA 

*: The instrument can use a 100-V or a 200-V power supply. Check that the voltage 
supplied to the instrument is less than or equal to the maximum rated voltage of the 
provided power cord (see page iv) before using it.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WARNING
Power cord 
(standard accessory) 
       
3-prong outlet 
                            3-3 
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3.4 Turning the Power ON and OFF 
 
 

Check the Following before Turning ON the Main Power Switch 
• Whether the instrument is installed correctly -> 3.2 Installation 
• Whether the power cord is connected correctly -> 3.3 Connecting the Power Supply 

 
Turning ON the Main Power Switch  

1. Turn the main power switch on the rear panel to the ON (I) position.  
The instrument enters standby mode. The STANDBY LED on the lower left of the 
front panel illuminates.  
 
 
 
 
 
 
 
 
 
 
 
 

Turning ON the Front Panel Power Switch  
2. Press the power switch on the front panel.  

The power is turned ON, the STANDBY LED in the lower left of the front panel turns 
OFF, and the POWER LED illuminates.  
 
 
 
 
 
 
 
 
 
 
 
 

Note 
 If the POWER LED does not illuminate even if the power switch is turned ON, 

turn OFF the power switch and main power switch, then check the following.  
• Whether the power cord is plugged in properly.  
• Whether the power supply outlet is of the correct voltage.  
• Whether the power fuse is blown.  
If there is no change after turning on the main power switch and power switch, 
please contact your nearest YOKOGAWA dealer for repairs.  
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Turning OFF the Front Panel Power Switch  
1. Turn OFF the OUTPUT switch. The OUTPUT LED turns OFF.  
2. Press the power switch on the front panel.  

The instrument enters STANDBY mode. (The STANDBY LED illuminates, and the 
POWER LED turns OFF.) 

 

  
 

 When OUTPUT is ON, do not turn OFF the power switch. Doing so can lead to 
malfunction. 

 
Turning OFF the Main Power Switch  

3. Turn the main power switch on the rear panel to the OFF (0) position.  
The STANDBY LED on the lower left of the front panel turns OFF.  
 

  
 

 When the power switch on the front panel is turned ON, do not turn the main 
power switch on the rear panel OFF. Doing so can lead to malfunction. 

 
Note 

 When not using the instrument, turn OFF the main power switch.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CAUTION

CAUTION
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3.5 Setting Up the Application 
 
 

System Requirements 
• PC:   A PC/AT compatible personal computer 
• OS:   Windows 2000 or Windows XP 
• CPU:   Pentium III, 500 MHz or faster 
• Memory:   256 MB or more 
• Hard disc:  10 MB or more of free space 
• Disc drive:  CD-ROM Drive 
• USB Port:   1 (USB 1.1, USB 2.0) 
 
Note 

 Set the PC power setting mode to Presentation or Always On.  
1. Choose Start > Control panel > Power options to open the power options 

properties dialog box.  
2. Click the Power settings tab, select Presentation or Always On from the 

power settings menu, then click the OK button.  
 

Installing the Software  
1. Log in with administrator privileges (under user name Administrator), then start 

Windows.  
2. Insert the AP9945 Portable BERT Software CD into the CD-ROM drive.  
3. Choose My Computer > CD-ROM. The CD-ROM dialog box is displayed. 

Double-click the setup.exe file in the CD-ROM. The Portable BERT Installation 
dialog box opens.  

4. Specify an installation location, then click the Finish button to start the installation.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. The message, “Portable BERT installation Successful!” is displayed. Click the OK 

button.  
 
 
 
 
 
 

Uninstalling the Software 
1. Log in with administrator privileges (under user name Administrator), then start 

Windows. Choose Start > Programs > Portable BERT > Uninstall Portable BERT. 
Uninstallation begins.  

2. Follow the on-screen instructions.  
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3.6 Connecting to a PC 
 
 

Connecting to a PC 
Check that the power to the PC and AP9945 are OFF, then connect the AP9945’s USB 
port to the PC’s USB port using the accessory USB cable.  
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3.7 Installing and Uninstalling USB Drivers 
 
 

Installing USB Drivers 
1. Use the accessory USB cable to connect the PC’s USB port to the AP9945’s USB 

port.  
2. Turn ON the power to the PC, then log in with administrator privileges (under user 

name Administrator).  
3. Insert the AP9945 Portable BERT Software CD into the CD-ROM drive.  
4. Turn ON the power switches to the AP9945 (on the rear and front panels). The Found 

New Hardware Wizard (USB <-> Serial) is displayed on the PC.  
 
 
 
 
 
 
 
 
 
 
 
5. Choose Install from a list or specific location (Advanced), then click the Next 

button.  
 
 
 
 
 
 
 
 
 
 
 
6. Choose Search for the best driver in these locations, then click the Next button. 

Installation begins, then Found New Hardware Wizard Complete is displayed.  
7. Click the Finish button. The Found New Hardware Wizard (USB Serial Port) is 

displayed.  
8. Perform steps 5 and 6 in the same manner, then click the Finish button.  
 

Uninstalling USB Drivers 
1. Remove the USB cable from the PC’s USB port and the AP9945’s USB port.  
2. Turn ON the power to the PC, then log in with administrator privileges (under user 

name, Administrator).  
3. Insert the AP9945 Portable BERT Software CD into the CD-ROM drive.  
4. Select the following files from the CD-ROM drive folder, then double-click.  

CD-ROM drive¥driver¥FTDIUNIN.EXE 
The uninstaller launches.  

5. Click the Continue button to execute the Uninstallation.  
 
 
 
 
 
6 Uninstall Complete is displayed. Click the Finish button.  



 

IM 734001-01E                                                                3-9 

B
efore Starting M

easurem
ent 

33

3.8 Setting Up a COM Port 
 
 

Note 
• 
 
 

• 

When setting up a COM port, connect the AP9945’s USB port to the PC’s USB 
port using the accessory USB cable, then turn ON the power to the PC and 
AP9945. 
Log in with administrator privileges (under user name Administrator) and install 
the application (Portable BERT Software) and the USB drivers on the PC. 

 
Setting Up a COM Port 

1. Choose Start > Control panel > System. The system properties dialog box opens.  
2. Select the Hardware tab, then click the Device Manager button. The device 

manager dialog box opens.  
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Check the port number used by the PC next to USB Serial Port (COMn) under Ports 

(COM and LPT).  
 
 
 
 
 
 
 
 
4. Choose Start > Programs > Portable BERT > pbert. The application launches, and 

the main screen is displayed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Check the port number used by the PC 
for USB 

Main screen 
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5. Choose File > Preference from the menu. The Preference dialog box opens.  
6. Select the number used by the PC’s USB port in the COM Port menu, then click the 

OK button.  
 
 
 
 
 
 
 
 

Checking Communications 
7. Click the Connect button. The Progress Bar popup screen will appear.  
 
 
 
 
 
● When the AP9945 and PC are connected 

If a connection is successfully opened between the AP9945 and PC, the BERT-PC 
Connection status display turns green.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
● When the AP9945 and PC are not connected 

If a connection failed to be opened between the AP9945 and PC, an error dialog box 
appears. The BERT-PC Connection status display remains gray.  

 
 
 
 
8. Click the OK button. (-> For corrective actions, see section 5.2. ) 
 
Note 

• 
 
 

• 

After installing the application (Portable BERT Software) on the PC, it may take 
up to two minutes to connect to the AP9945 on the first attempt. From the 
second attempt, it should only take a few seconds.  
The AP9945 is ready for normal operation when the BERT-PC Connection status 
display turns green. It cannot be used if the status display is gray. 

 

Select the USB port number determined in step 3

Status indicator: 
green 
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3.9 Connecting the DUT 
 
 

1. Check whether the AP9945’s OUTPUT is turned OFF.  
2. Connect the AP9945’s I/O terminal to the DUT’s I/O terminal with a coaxial cable.  
 

 

  
 

● 
 

● 
 

● 
  

●  
 
 

●  
 
 

●  
 
 
 

●  
● 

Do not apply a voltage to the input terminals exceeding the maximum input 
voltage. Damage to the instrument can result.  
Do not apply an external voltage to the output terminals. Damage to the 
instrument can result.  
When connecting or disconnecting the cable to/from the input/output terminal, 
always turn OUTPUT OFF.  
When connecting or disconnecting the cable to/from the input/output terminal, 
tighten the connector at the specified tightening torque (0.9 N-m) using a torque 
wrench.  
Do not open output terminals. Terminate them with 50 Ω (terminators supplied 
with the instrument). Additionally, terminate the end of the cable to be connected 
to the output terminal with 50 Ω in the same manner as described above. 
When making connections with the input/output terminals, use a grounding wrist 
strap so that the terminals are not charged by static electricity. If the connection 
cable is charged by static electricity, this may cause the unit to malfunction. 
Therefore, only make connections after the cables have been discharged. 
When connecting to the DUT, turn OUTPUT OFF.  
Use the specified connectors for connections to input/output terminals. If the 
terminal is connected to a connector other than one specified, this may cause 
the input/output terminal or the connector to break. Additionally, when 
connecting the input/output terminal to the connector, always connect it straight 
so that the input/output terminal and the connector do not slant. If they are 
connected in a slanted manner, this may cause the core wire of the input/output 
terminal or the connector to break. 

 
Note 

•  
 
 
 

•  

When using DATA IN (CDR) and REF CLOCK IN 
When the input signal of DATA IN (CDR) of the ED is not synchronized with the 
PPG, enter settings so that a frequency 16 or 64 times larger than the reference 
signal to be input to REF CLOCK IN is within ±100 ppm of the input data rate.  
When using DATA IN (CDR) and 10G CLOCK IN 
When the input signal of DATA IN (CDR) of the ED is not synchronized with the 
PPG, enter settings so that a frequency 16 or 64 times larger than the clock 
signal to be input to 10G CLOCK IN is within ±100 ppm of the input data rate.  

 
 
 
 
 
 
 
 
 

CAUTION
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Connecting the DUT 
● Use CDR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
● Do not use CDR 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*1:  If the DUT needs a CLOCK, connect it to the CLOCK OUT terminal.  
*2:  With the phase shifter, the phase is adjusted to a level suitable for the DUT’s input. 
*3: The 10G CLOCK IN (1/16, 1/64) terminal of the ED does not have a phase 

adjustment function. Adjust the phase to a level suitable for phase of the ED using a 
phase shifter.  

 
Connecting the External SG 

 
 
 
 
 
 
 
 
*1:  When using the REF CLOCK (1/16 or 1/64 of the bit rate) of the external SG, connect 

it to the REF CLOCK IN (1/16, 1/64) terminal of the AP9945. When using the EXT 
CLOCK of the external SG, connect it to the 10G CLOCK IN terminal of the AP9945’s 
PPG.  

 
Note 

 When using the REF CLOCK (1/16 or 1/64 of the bit rate), the signal of the 
external SG must be a square waveform.  

 
Connecting the Trigger Terminal 

See section 2.6. 
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4.1 Starting/Exiting the Application 
 
 
 

 Starting the Application and Connecting to the AP9945  
1. On the PC, choose Start > Programs > Portable BERT > pbert. The application 

launches, and the main screen is displayed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click the Connect button. The Progress Bar popup screen will appear.  
 
 
 
 
 

If a connection is successfully opened between the AP9945 and PC, th
Connection status display turns green, and the button display changes to 
The button toggles between Connect and Disconnect.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Green
Main screen 
ating Procedures 

e BERT-PC 
Disconnect. 
     4-1 
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 Disconnecting from the AP9945 and Exiting the Application 
1. Click the Disconnect button. The BERT-PC Connection status display turns gray, 

and the button display changes to Connect.  
2. Choose File > Quit from the menu. The application closes.  
 
 
 

 Starting the Application and Connecting to the AP9945  
● Starting using the desktop icon 

You can also start the application by double-clicking the pbert icon on the desktop.  
 
 
 
 

● You can also connect to the AP9945 by choosing Function > Connect from the 
menu.  

 
● When the AP9945 and PC are not connected 

If a connection failed to be opened between the AP9945 and PC, an error dialog box 
appears. The BERT-PC Connection status display remains gray.  
 
 
 
 
 
For the procedure, see section 5.2.  
 

 Disconnecting from the AP9945 and Exiting the Application 
● You can also disconnect from the AP9945 by choosing Function > Disconnect from 

the menu.  
 
● Auto-saving settings 

You can have the application automatically save current settings to hard disk when 
closing the application, and automatically restore the settings upon the next session.  
Note that Output is forcibly turned OFF.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Explanation 
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4.2 Setting Data Items 
= For details about the function, see section 2.2 = 

 
The items in the Data tab let you set PPG and ED send/receive data patterns.  
 
 

1. Click the Data tab in the main screen. The Data item screen is displayed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 PPG Item 
• Divide Ratio Setting 
2. Select the divide ratio (1/1, 1/2, 1/7, or 1/8) from the Divide Ratio list.  
 

 PPG/ED Common Items 
● When Using a PRBS 

• Pattern Settings 
3. Select PRBS from the Pattern list. The Data list is enabled.  
• Data Settings 
4. Select a PRBS pattern (PRBS7, PRBS15, PRBS23, PRBS31) from the Data list.  
 

● When Using a Program 
• Pattern Settings 
3. Select Program from the Pattern list. The Edit button is enabled.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Click to invert the PPG 
output data logic 

Click to invert the ED 
input data logic 

Select to copy 
the ED setting 
data to the PPG 

Select to copy 
the PPG setting 
data to the ED 
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4. Click the Edit button. The PPG Program Pattern (ED Program Pattern) dialog 

box opens.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Program Pattern Settings 
5. Set the pattern length by entering a number in the Length box, or by selecting a 

number in the spin box (2, 4, 8, 16, 32, 64, or 128 Bytes). The pattern input area 
is ready to accept the specified number of bytes.  

6. Select a pattern input format (HEX, BIN) from the Format list.  
7. In the pattern input area, input a program pattern of the format specified in step 6.  
8. Click the Apply button. The settings are applied to the AP9945.  
 
• Loading Program Patterns 
5. Click the Import button. The Name of Program Pattern File to Import dialog box 

is displayed.  
 
 
 
 
 
 
 
 
 
6. Select the file to load, then click the OK button.  
 
• Saving Program Patterns 
5. Click the Export button. The Name of Program Pattern File to Export dialog box 

is displayed.  
 
 
 
 
 
 
 
 
 
6. Input a file name, then click the Save button.  
 

Spin button 
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• Setting the Polarity 
Inverting the data logic 
9. Click the Normal button. The button display changes to Invert, the color changes 

to yellow, and the data’s logic is inverted. The button toggles between Normal 
and Invert.  

 
 
Restoring the original data logic 
10.  Click the Invert button. The button display changes to Normal, the color 

changes to gray, and the data’s original logic is restored.  
 
• Setting the Coupling 
Copying the setting data of the PPG to the ED  
11. Select the Coupling to PPG check box. The Coupling to ED check box is 

selected, and the PPG setting data is copied to the ED.  
 
Copying the setting data of the ED to the PPG 
11. Select the Coupling to ED check box. The Coupling to PPG check box is 

selected, and the ED setting data is copied to the PPG.  
  

 
 
● Divide Ratio 

You can set the output data rate of DATA OUT and the DATA OUT terminal. You can 
select a 10 Gbit/s band data rate, or a low bit rate of 5, 2.5, or 1.25 Gbit band. Only 
valid for the PPG.  

1/1:  10 Gbit/s band data rate 
1/2:  5 Gbit/s band data rate 
1/4:  2.5 Gbit/s band data rate 
1/8:  1.25 Gbit/s band data rate 

 
● Pattern: 

You can set output data terminal (DATA OUT, DATA OUT) patterns with the PPG, and 
input data terminal (DATA IN, DATA IN (CDR)) patterns with the ED. You can select a 
PRBS or Program pattern.  

PRBS: PRBS pattern 
Program: Program pattern  

 
● Data 

You can set the number of stages for the PRBS pattern. This is enabled when PRBS 
is selected for the Pattern.  

PRBS7, PRBS15, PRBS23, PRBS31 
 

● Format 
You can select BIN or HEX for the input format for the program pattern.  
• HEX 
 
 
 
• BIN 
 
 
 
 
 

Explanation 
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● Program Pattern 

The current program pattern’s number of zeros, number of ones, mark ratio, and 
mark ratio limit values (Min and Max) are displayed as shown below.  
 
 
 
 
 
The program patterns that can be set are limited by the mark ratio. Set the program 
patterns so that the (mark limitation is fixed) current mark ratio is restricted to the 
range indicated by the mark ratio limit values.  
 
Click the Apply button to copy the program pattern data from the PC to the AP9945.  
 

● Loading Program Patterns 
Text files created in HEX and BIN format are loaded as program pattern files. These 
files can be edited in a text editor or other program.  
• HEX format: 
 Consists of 0x followed by two characters (0 to F), followed by a newline. 

0x00 
0x01 
0x02 
:  
0xFF 

 
• BIN format: 
 Consists of eight characters (zeros and ones), followed by a newline.  

00000000 
00000001 
00000010 
  :  
11111111 

Note 
 Set the pattern length of the loaded pattern file to 2, 4, 8, 16, 32, 64, or 128 

Bytes. If the pattern file is of another length, an error will be displayed and the file 
will not be loaded.  

 
● Saving Program Patterns 

You can save program patterns created on the AP9945 as text files. They are saved 
to the format specified under Format (HEX or BIN).  
 

● Polarity 
For the PPG, the logic of the output data (DATA OUT, DATA OUT) is inverted.  
For the ED, the logic of the input data (DATA IN, DATA IN (CDR)) is inverted.  
 

No. of 0s No of 1s  Mark ratio  Mark ratio limits (Min，Max) 
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4.3 Setting Interface Items 
= For details about the function, see sections 2.3, 2.4, 2.5, and 2.6 = 

 
For the interface items, set the Trigger, Clock Source, and Bit Rate of the PPG, and the 
Trigger, Port Select, and Threshold Level of the ED.  
 
 

1. Click the Interface tab in the main screen. The Interface item screen is 
displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Interface/PPG 
● Trigger Setting 

2. Select a trigger output for the PPG from the Trigger list.  
(When the Divide Ratio=1/1: Pattern, 1/16, 1/64; when the Divide Ratio=1/2, 1/4, 
or 1/8: Pattern, 1/1) 

 
● Clock Source Setting 

• Internal/External Setting 
3. Select the clock that drives the PPG (Internal, External 1/16, External 1/64, or 

External 10G) from the Internal/External list.  
 
• Bit Rate Setting 
Can be selected when Internal is set 
4. Select a bit rate band to use from the Bit Rate list.  
 
• Bit Rate Variable Setting 
Can be set when SG is set 
5. Set the bit rate by entering a number in the Bit Rate variable setting box, or by 

selecting a number in the spin box. 
 

 Interface/ED 
● Trigger Setting 

6. Select a trigger output for the ED from the Trigger list (Pattern, 1/16, 1/64).  
 

● Port Select Setting 
7. Click to select DATA IN or DATA IN (CDR) under Port Select.  
 

● Threshold Level Setting 
8. Set the threshold level by entering a number in the Threshold Level box, or by 

selecting a level in the spin box.  
 

Procedure 

Click to select 

Bit Rate variable setting 

Up button 
 
Down button 

Slider  
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 Interface/PPG 
● Trigger 

You can select a trigger signal to be output from the TRIGGER OUT terminal of the 
PPG.  
The items that can be set differ depending on the divide ratio.  
 Divide Ratio=1/1:   Pattern, 1/16, 1/64 
 Divide Ratio=1/2, 1/4, 1/8:  Pattern, 1/1 
 
• Pattern  

You can output a trigger signal synchronized to the pattern of the PPG.  
For PRBS, a positive pulse signal is output once every 128 cycles.  
For Program, a repeating pulse signal of 0 and 1 is output every 1024 bits of the 
output pattern rate regardless of the Length setting.  

• 1/16:  
A clock signal is output which is 1/16 of the output pattern rate of the PPG.  

• 1/64:  
A clock signal is output which is 1/64 of the output pattern rate of the PPG.  

• 1/1:  
A clock signal of 1/2, 1/4, or 1/8 is output corresponding to the low bit rate.  

 
● Clock Source 

You can select a clock source that drives the PPG.  
• Internal:  

An internal clock source is used. 
• External 1/16 or External 1/64:  

Use a clock of 1/16 (External 1/16) or 1/64 (External 1/64) of the output bit rate 
that was input to the REF CLOCK IN (1/16, 1/64) terminal.  

• External 10G:  
Use a clock of 1/1 of the output bit rate that was input to the 10G CLOCK IN 
terminal.  

 
● Bit Rate  

You can set the bit rate. 
• For SG  

All items below are displayed, and one can be selected.  
• When there is one oscillator 

One of the bit rates of the oscillators listed in the items below is displayed. It 
cannot be selected.  

• When there are two oscillators 
Two of the bit rates of the oscillators listed in the items below are displayed and 
one can be selected.  
 

List items 
9.953280 [Gbit/s] OC-192/STM64, 10GBASE-W 
10.312500 [Gbit/s] 10GBASE-R 
10.664229 [Gbit/s] OC-192/STM64 FEC (10.664229=9.953280*15/14) 
10.709225 [Gbit/s] G.709 (10.709225=9.953280*255/237) 
11.095728 [Gbit/s] 10GBASE-R FEC (11.095728=10.312500*255/237) 
11.317642 [Gbit/s] 10G Fiber Channel FEC (11.317642=10.518750*255/237) 

 
● Bit Rate Variable Setting 

You can set the bit rate when SG is set. In the case of a oscillator, it is dimmed and 
cannot be selected.  
Setting range:  9.95 to 11.32 [Gbit/s], in steps of 0.00001 [Gbit/s] 

Explanation 
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 Interface/ED 
● Trigger 

You can select a trigger signal to be output from the TRIGGER OUT terminal of the 
ED.  
• Pattern:  

Outputs a trigger signal synchronized to the pattern of the ED.  
For PRBS, a positive pulse signal is output once every 128 cycles.  
For Program, a repeating pulse signal of 0 and 1 is output every 1024 bits of the 
input pattern rate regardless of the length setting.  

• 1/16:  
A clock signal is output which is 1/16 of the input pattern rate of the ED.  

• 1/64:  
A clock signal is output which is 1/64 of the input pattern rate of the PPG.  

 
● Port Select 

You can set up the data input terminal of the ED.  
• DATA IN:  

Select when not using CDR. Input a clock signal synchronized to the data signal to 
the DATA IN and 10G CLOCK IN terminals. Adjust with a phase shifter or other 
device so that the relationship between the data and clock phases is such that the 
data conversion point matches up with the falling of the clock.  

• DATA IN (CDR):  
Select when using CDR. The DATA IN (CDR) terminal is used.  
 

● Threshold Level Setting 
You can click the slider Up and Down buttons, or drag the slider to set the Threshold 
Level.  
Setting range:  -0.350 to 0.350 [V], in steps of 0.001 [V] 
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4.4 Setting Measurement Items 
 
 

With Measurement items, you can set the measurement mode and log function.  
 
 

1. Click the Measurement tab in the main screen. The Measurement item screen is 
displayed.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Measurement Setup 
● Using Manual Measure Mode 

2. Select Manual from the Measure Mode list. Period is dimmed and cannot be 
selected.  

 
● Using Single Measure Mode  

2. Select Single from the Measure Mode list. Period is enabled and can be 
selected.  

3. Set the measurement time by entering a number in the Period box, or by 
selecting a number in the spin box. (1 to 99) 

4. Select the units for the measurement time (Sec, Min, Hour) from the Period units 
list.  

 
 Logging Setup 

5. Click the Setup button. The Logging Setup dialog box opens.  
 
 
 
 
 
 
 
 
 
 

● Enabling the Logging Function. 
6. Select the Logging? check box. The logging items become enabled for setting.  
• Logging Period Setting 
7. Set the logging period by entering a number in the Logging Period box, or by 

selecting a number in the spin box. (1 to 99) 
8. Select the units for the logging period (Sec, Min, Hour) from the logging period 

units list.  
 

Procedure 

Select to use the logging 

Select to save a log at the logging 
interval whenever an error/alarm 
occurs.  
To save all logs at the logging 
interval, clear the check box.  
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• Logs are saved at the logging period only when an error or alarm occurs 
9. Select the Logging Error or Alarm only check box.  
 
• All logs are saved at the logging period 
9. Clear the Logging Error or Alarm only check box.  
 
• Enter a file name 
10. Click the Browse button to open the Save as dialog box.  
 
 
 
 
 
 
 
 
 
 
11. Input a save destination and file name, then click the Save button. The Save as 

dialog box closes, and the specified directory and file name are displayed under 
File Name in the Logging Setup dialog box.  

 
 
 
 
 
 
 
 
 
12. Click the OK button. The Logging Setup item displays Logging: ON, and the 

Period, Mode, and File Name are displayed.  
 
 
 
 
 
 

● Disabling the Logging Function   
6. Clear the Logging? check box. The logging item becomes dimmed and cannot 

be set.  
7. Click the OK button. The Logging Setup item displays Logging: OFF.  

 
 
● Measure Mode 

• Single 
Click the Start button to start measurement. When the measurement time as 
specified under Period elapses, measurement automatically stops. The 
measurement time can be set from 1 second to 99 minutes.  

• Manual 
Click the Start button to continue measurement until the Stop button is clicked.  

 
 
 
 

Explanation 
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● Format of the Log File 

The log file is in text format. It can be loaded by a text editor or spreadsheet 
program.  
 
If the same file name already exists when setting files, it is added to the end of the 
log.  
 
Logging period: 1 sec. to 99 minutes 

 
Example) 

Logging period: 10 sec., measurement time: 1 minute, Logging Error or Alarm only: 
Log file when selected 

 
 
 
 
 
 
 
 
 
 
 
 
 

No Item Description 
1) Start Shows the measurement start time. MM-DD-YYYY hh: mm: 

ss 
2) Clock Source Shows the clock source and bit rate.  
3) Period Shows the logging period.  
4) (Logging period 

data) 
Shows the logging period data.  
No., measurement elapsed time (Elapsed), log time (Time), 
ErrorCount value, SyncLoss value [µsec], CdrUnlock*1 
value, LossOfSignal value, SgUnlock*2 value.  

5) Stop Shows the measurement stop time. MM-DD-YYYY hh: mm: 
ss 

6) Elapsed Time  
7) Last Result Displays the final results.  

SyncLoss value [µsec], ErrorCount value, ErrorRate value 
*1 Enabled when set to DATA IN (CDR).  
*2 Enabled with the SG type and when Clock Source is set to Internal.  
 
Note 

 Measurement items cannot be changed during measurement.  

1) 
2) 

3) 

Start 10-28-2005 11:47:36

Clock Source Int 9.95334 [Gbit/s]

Period 10sec

NO. Elapsed Time ErrorCount SyncLoss CdrUnlock LossOfSignal SgUnlock

000001 000010 11:47:46 8.000000E+00 0.000000E+00 0 0 0

000002 000020 11:47:56 2.000000E+00 0.000000E+00 0 0 0

000003 000030 11:48:06 2.000000E+00 0.000000E+00 0 0 0

000004 000060 11:48:36 3.000000E+00 0.000000E+00 0 0 0

Stop 10-28-2005 11:48:36

Elapsed Time 00:01:00

Last Result

SyncLoss 0.000000E+00

ErrorCount 1.500000E+01

ErrorRate 2.511719E-11

4) 

5) 

6) 

7) 
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4.5 Setting Data/Clock Items 
= For details about the function, see section 2.3 = 

 
With the Data/Clock items, you can set the data amplitude, offset, cross point, and the 
clock offset of the PPG interface.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
●  Data Amplitude 

1. Set the amplitude by entering a number in the Amplitude box, or by selecting a 
number in the spin box.  

 
● Data Offset 

2. Set the offset by entering a number in the Offset box, or by selecting a number in 
the spin box.  

 
● Data Cross Point (Enabled When the PPG Pattern Setting is PRBS) 

3. Set the data cross point by entering a number in the Cross Point box, or by 
selecting a number in the spin box.  

 
● Clock Offset 

4. Set the clock offset by entering a number in the Offset box, or by selecting a 
number in the spin box.  

 
 
● The Data/Clock items can be set by clicking a slider’s Up and Down buttons, or by 

dragging the slider.  
 
● Data Cross Point is enabled when the PPG Pattern setting is PRBS. When Program 

is selected, the Data Cross Point is fixed at 50%.  
 
● The setting ranges for the Data/Clock items are as follows.  

 
• Data Amplitude:  0.50 to 2.00 [V], in steps of 0.01 [V] 
 
• Data Offset:  -2.00 to 2.00 [V], in steps of 0.01 [V] 
 
• Data Cross Point:  30 to 70 [%], in steps of 1 [%] 
 
• Clock Offset:  -2.00 to 2.00 [V], in steps of 0.01 [V] 

 
 

Procedure 

Slider 

Up button 
 
Down button 

Explanation 
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4.6 Turning Output ON and OFF 
 
 

 
 Things to Check before Turning Output ON 

● Is the output terminal connected to the DUT correctly? And are the terminators 
attached? 

● Are appropriate values set for the Data Amplitude, Data Offset, and Clock Offset?  
 

  
 

●  
 

●  
 

To protect the output circuit, do not open the output terminals, and terminate 
them with a 50 Ω-load.  
To protect the DUT when connecting the instrument and DUT, adjust the output 
level so that it does not exceed its absolute maximum rating, or insert an 
attenuator or similar device.  

 
 Turning ON the Output 

1. When the Output indicator is dimmed, click the Output ON/OFF button under 
Control/PPG. The indicator display turns green, and output is ON.  

 
 
 
 
 
 
 

 Turning OFF the Output 
2. When the Output indicator is green, click the Output ON/OFF button under 

Control/PPG. The indicator display turns gray, and output is OFF.  
 
 
 
 
 
 
 
 
 
Output ON/OFF is enabled when the AP9945 is connected to the PC (the BERT-PC 
Connection indicator is green).  
 
You can perform the same operation using the OUTPUT ON/OFF switch on the front 
panel of the main unit.  
The Output ON/OFF button and OUTPUT ON/OFF switch are interlocked.  
 
 
 
 
 
 
 
 

Procedure 

CAUTION 

Green: Outut ON 

Gray: Output OFF 

Explanation 
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4.7 Starting and Stopping Measurement 
 
 

 
 
 
 
 
 
 
 

 Starting Measurement 
Click the Start button to start measuring.  
 

 Restarting Measurement 
Click the Start button during measurement to clear the measured results and restart 
measurement.  
 

 Stopping Measurement 
Click the Stop button during measurement to stop measuring.  
 
 
 
During measurement, the Start and Stop buttons turn yellow.  
 
 
 
 
 
 
When the measurement mode is Single, click the Start button to start measurement. 
After the measurement time specified under Period elapses, measurement 
automatically stops. When the measurement mode is Manual, click the Start button to 
start measurement. Measurement continues until the Stop button is clicked.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Start button  Stop button 

Explanation 
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4.8 Adding Errors 
 
 

 
 Setting Error Types 

Select the type of error to add (Single, 1E-3 to 1E-12) from the Error Addition list under 
Control/PPG.  
 
 
 
 
 
 
 

 Adding the Error or Stopping the Error Addition 
● When Error Addition is Single 
1. When the ON button is clicked, one bit error is added.  
 
● When Error Addition is 1E-3 to 1E-12 
1. When you click the ON button the display changes to OFF, the color changes to 

yellow, and bit error is added according to the selected error rate.  
 
 
 
 
2. When you click the OFF button the display changes to ON, the color changes to gray, 

and bit error adding stops.  
 
 
 
Added Error Types 
Single, 1E-3, 1E-4, 1E-5, 1E-6, 1E-7, 1E-8, 1E-9, 1E-10, 1E-11, 1E-12 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Explanation 
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4.9 Measurement Result 
 
 

Measured results are displayed under Measurement Result. Also, you can set the time for 
display updating of the measured results, and zoom the results.  
 
 

 Setting TIMED 
1. Select the time at which the measured results are updated (100 ms, 1 sec, 10 sec, 

100 sec, or 150 sec) from the TIMED list.  
 
 
 
 
 
 
 

 Zooming the Measured Results 
1. Click the Zoom In/Out button to zoom the measured results in or out.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click the Zoom In/Out button again to return the measured results to normal display.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Zoom in/out button 

Zoom in/out button 
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Item Description 
ELAPSED TIME Shows the time elapsed since measurement started.  
BIT RATE Shows the bit rate of the receive clock of the ED. [Gbit/s] 
SG UNLOCK Shows an indicator of the synchronization status. Enabled 

with the SG type and when Clock Source is set to Internal.  
 Green: SG normal status (synchronization established)  
 Red: SG unsynchronized 
 Gray: Invalid status 

LOSS OF SIGNAL Shows an indicator of the status of the input signal of the ED. 
 Green: Normal status 
 Red: Signal disconnected  
 Gray: Invalid status 

CDR UNLOCK Shows an indicator of the status of the CDR function of the 
ED. Enabled when Port Select is set to DATA IN (CDR).  
 Green: Normal status 
 Red: Error status 
 Gray: Invalid status 

SYNC LOSS Shows the pattern sync loss status of the ED using an 
indicator, and shows the pattern sync loss time using a 
numeric value.  
• Pattern sync loss status 
 Green: Normal status 
 Red: Error status 
 Gray: Invalid status 
• Pattern sync loss time 
 Display range: 0 to 3.564000E+11 [us] 

BIT ERROR Shows the bit error status of the ED using an indicator, and 
shows the bit error number using a numeric value.  
• Bit error status 
 Green: Normal status 
 Red: Bit error detection status 
 Gray: Invalid status 
• Number of bit errors  
 Display range: 0 to 1.008120E+15 [bit] 

ERROR RATE Shows the bit error rate of the ED using a numerical display. 
 Display range:  
  0.000000E-10 to 0.000000E-16 (errors: none) 
  2.478654E-16 to 2.498779E-01 (errors: occurs) 

 
 
 
 
 
 
 
 
 
 
SYN CLOSS, BIT ERROR, and ERROR RATE are displayed under CURRENT and 
TIMED. CURRENT displays the total number of measured results since measurement 
started. TIMED displays the measured results at each update time. TIMED is useful 
when investigating increases and decreases in errors. Even if TIMED switches during 
measurement, only the display switches and this does not affect the measured values.  

Explanation 

Totalized measured results  Measurement at each update 
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4.10 Loading and Saving Setting Values 
 
 
 

 Loading Setting Values  
1. Choose File > Load from the menu. The Open dialog box opens.  
 
 
 
 
 
 
 
 
 
 
2. Select a file to load, then click the Load button. The setting values are loaded.  
 

 Saving Settings 
1. Choose File > Save from the menu. The Save as dialog box opens.  
 
 
 
 
 
 
 
 
 
 
2. Select a file to save, then click the Save button. The set value is saved. 
 
 
 
 
The extension for setup files is .setup.  
 
OUTPUT ON/OFF and Logging Setup information is not saved in settings files.  
The OUTPUT ON/OFF and Logging Setup information from before the load is held.  
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Explanation 
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4.11 Displaying the Version 
 
 
Displays version information for the AP9945.  
 
 
 
1. Choose Help > About from the menu. The About dialog box opens.  
 
 
 
 
 
 
 
 
 
 
2. Click the Close button. The About dialog box closes.  
 
 

Procedure 
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5.1 When Trouble Occurs 
 
 

Troubleshooting 
● If a message appears on screen, refer to the pages indicated below.  
● If servicing is necessary, or if the instrument is not operating correctly after 

performing the corrective actions below, contact your nearest YOKOGAWA dealer.  
 

Symptoms and Corrective Actions Related 
Section

The power is not turned ON.   
Securely connect the accessory power cord plug to the power connector on 
the rear panel.  

3.3 

Check that the main power switch on the rear panel is ON.  3.4 
Check that the power switch on the front panel is ON.  3.4 

 

Check whether the fuse is blown out.  5.4 
Synchronization could not be established.   

Check cable connections.  1.2, 3.9
Check the port selection (DATA IN (CDR), DATA IN) and connection of the 
ED, and if the settings are different from the connections, make the settings 
match.  

4.3 

Check that the OUTPUT of the PPG is ON.  4.6 
Check the DATA setting of the PPG and ED. If the setting of the PPG is 
different from that of the ED, make these settings match with each other. 

4.2 

Check the value of the Data Amplitude. If the amplitude is small, correct it. 4.5 
Check the value of the Threshold Level. If the value is inappropriate, change 
it.  

4.3 

 

When using DATA IN, adjust the phase of the data and clock.  1.2, 3.9
The sync loss error occurs.  

Check the data settings of the PPG and ED. If the setting of the PPG is 
different from that of the ED, make these settings match with each other. 

4.2 

Check Error Addition, and if the setting is ON, turn it OFF.  4.8 
Check the value of the Data Amplitude. If the amplitude is small, correct it. 4.5 

 

Check the value of the Threshold Level. If the value is inappropriate, change 
it.  

4.3 

Output waveform is noisy.   
Check cable connections.  1.2, 3.9
Check the output terminal. If there are unused terminals, connect the 
accessory terminators.  

1.2, 3.9
 

Use cables and connectors that support the frequency characteristics.  - 
The fan stopped.   
 1. Hold down the power switch on the front panel for one second or longer. 

The power is OFF.  
2. Turn OFF the main power switch on the rear panel.  
3. Contact your nearest YOKOGAWA dealer for repairs.  

3.4 
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5.2 Error Messages and Corrective Actions 
 
 

Error Messages 
When using the AP9945, messages may be displayed on the screen of the controller PC. 
The meanings of the messages and their corrective actions are explained below. If 
“service is required” is indicated under corrective actions, contact your nearest 
YOKOGAWA dealer for repairs.  

 
Message Trouble Corrective Action Related 

Section
Check the COM port of the instrument 
and controller PC. If they are different, 
make them the same.  

3.8 

Check the connection between the 
instrument and the controller PC. 
Connect the accessory USB cable 
between the instrument and the 
controller PC.  

3.6 

It failed in open of the COM 
port. 

Failed to open the COM 
port  

Check that the power to the 
instrument is ON.  

3.4 

The accessory USB cable between 
the instrument and the controller PC 
may be disconnected. Connect the 
cable then try the connection again.  

3.7 Initialize was end in failure. 
error number:100 

EEPROM Read time out 

The power to the instrument may be 
OFF. Turn the power ON, then try the 
connection again.  

3.4 

Initialize was end in failure. 
error number:110 

Data file open error Reinstall the software.  3.5 

Initialize was end in failure. 
error number:111 

Data file size error Reinstall the software.  3.5 

Initialize was end in failure. 
error number:112 

Data file version error Reinstall the software.  3.5 

Initialize was end in failure. 
error number:113 

Data file error Reinstall the software.  3.5 

Sorry, can not change while 
measuring. 

Error during measurement Settings cannot be changed during 
measurement. Stop measurement 
before changing settings.  

4.4, 4.7

Format error :  
invalid character(****). 

File format  
Illegal character error 

The loaded program pattern file may 
contain illegal characters, or the file 
may be corrupt. Check the contents of 
the file.  

4.2, 
4.10 

Format error:  
pattern length is wrong. 

File format  
Program pattern length  
error 

The loaded program pattern length 
may be illegal, or the file may be 
corrupt. Check the contents of the file.  

4.2, 
4.10 

Please input [FileName]. File name not entered A file name was not entered. Enter a 
file name.  

4.2, 
4.10 
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5.3 Maintenance and Inspection 
 
 

To ensure normal operation of the instrument, it is recommended to perform regular 
maintenance and inspection.  

 
Calibration Cycle 

It is recommended to carry out the performance test described below once per year.  
 

Performance Test 
After an inspection has been completed, the performance results are recorded in the 
performance test record sheet. The performance test record sheet is a list stating all 
tested specifications and allowable limits. The test result records can be used to 
compare the data after completion of the periodic maintenance, troubleshooting, repair, 
and adjustment.  
 

Recommended Test Instruments 
The following list shows the measuring instruments necessary to carry out the performance 
test. Use a measuring instrument with the recommended level of performance and functions 
or higher.  
 

Accessory Name Performance Requirements Recommended 
Instruments 

Digital oscilloscope Digital Communications Analyzer
Dual Channel 50 GHz Electrical 
Plug-In Module 

Agilent 86100A 
Agilent 83484A 

Phase shifter 3.5 mm-connector type HLS-JJ-13 manufactured 
by Hirose Electric 

Attenuator 10 dB (3.5 mm-connector type) 
20 dB (3.5 mm-connector type) 

INMET 41KC-10 
INMET 41KC-20 

Coaxial cable 3.5 mm-connector type 
SMA connector type 
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(1) BER Measurement (CDR)  
Description 

Correct functioning of the PPG-ED (CDR) is verified with BER measurement using 
PPG-ED loop back.  
 

Specifications 
No error occurs after measurement for five minutes. 
 

Procedures 
1. Insert a 10 dB-attenuator into the DATA IN (CDR) terminal of the ED of the AP9945 

and connect to the DATA OUT terminal of the PPG with a coaxial cable.  
 
2. Set up the AP9945 as follows.  

 Data Offset: 0.00 V  Polarity:  Normal 
 Data Cross Point: 50%  Coupling to PPG: Select 
 Clock Source: Internal  Divide Ratio: 1/1 
 Bit Rate*: 11.32 Gbit/s Pattern:  PRBS 
 Clock Offset: 0.00 V  Data:  PRBS31 
 Port Select: DATA IN(CDR) Measure Mode: Single 
 Threshold Level: 0 V  Period:  5 Min 
 *:In case of oscillator type, the highest possible frequency setting 

 
3. Set the AP9945’s data amplitude to 0.5 V and start the BER measurement.  
 
4. In the same manner, set the data amplitude to 2.0 V and start the BER measurement.  
 

Connection Diagram 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

AP9945
PORTABLE BERT

OUTPUT

POWER

REF CLOCK IN
(1/16,1/64)

1.0Vp-p MAX

CLOCK IN10G

1.0Vp-p MAX

PULSE PATTERN

CLOCK OUT

0.6Vp-p

DATA OUT

0.5Vp-p 2.0Vp-p 0.5Vp-p 2.0Vp-p

GENERATOR

CLOCK OUT

0.6Vp-p

DATA OUT

TRIGGER OUT

0.6Vp-p

ERROR DETECTOR

10G CLOCK IN

1.0Vp-p MAX

DATA IN (CDR)

0.7Vp-p MAX

TRIGGER OUT

0.6Vp-p

DATA IN

0.6Vp-p MAX

ALL PORTS

DATA OUT

SF 104/2x11PC3.5-42 700 mm 
Coaxial cable 

ATT10dB 
41KC-10 

ATT
      IM 734001-01E 

DATA IN (CDR) 
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(2) BER Measurement (No CDR)  
Description 

Correct functioning of the PPG-ED (no CDR) is verified with BER measurement using 
PPG-ED loop back.  
 

Specifications 
No error occurs after measurement for five minutes. 
 

Procedures 
 

1. Insert a 10 dB-attenuator into the DATA IN terminal of the ED of the AP9945 and 
connect to the DATA OUT terminal of the PPG with a coaxial cable.  

 
2. Insert a phase shifter into the 10G CLOCK IN terminal of the ED of the AP9945 and 

connect to the CLOCK OUT terminal of the PPG with a coaxial cable.  
 
3. Set up the AP9945 as follows.  

 Data Offset: 0.00 V  Polarity:  Normal 
 Data Cross Point: 50%  Coupling to PPG: Select 
 Clock Source: Internal  Divide Ratio: 1/1 
 Bit Rate*: 10.71 Gbit/s Pattern:  PRBS 
 Clock Offset: 0.00 V  Data:  PRBS31 
 Port Select: DATA IN  Measure Mode: Single 
 Threshold Level: 0 V  Period:  5 Min 
 *:In case of oscillator type, the highest possible frequency setting 

 
4. Set the AP9945’s data amplitude to 0.5 V and start the BER measurement.  
 
5. In the same manner, set the data amplitude to 2.0 V and start the BER measurement.  
 

Connection Diagram 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

AP9945
PORTABLE BERT

OUTPUT

POWER

REF CLOCK IN
(1/16,1/64)

1.0Vp-p MAX

CLOCK IN10G

1.0Vp-p MAX

PULSE PATTERN

CLOCK OUT

0.6Vp-p

DATA OUT

0.5Vp-p 2.0Vp-p 0.5Vp-p 2.0Vp-p

GENERATOR

CLOCK OUT

0.6Vp-p

DATA OUT

TRIGGER OUT

0.6Vp-p

ERROR DETECTOR

10G CLOCK IN

1.0Vp-p MAX

DATA IN (CDR)

0.7Vp-p MAX

TRIGGER OUT

0.6Vp-p

DATA IN

0.6Vp-p MAX

ALL PORTS

 

SF 104/2x11PC3.5-42 700 mm co

ATT10dB 
41KC-10 

ATT

Phase shifter

CLOCK OUT 

10G CLOCK IN 
DATA IN
DATA OUT
   

axial c
                 5-5 

able 
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(3) Output Waveform Test 
Description 

Check that the output waveform of the DATA OUT of the PPG is within the specification 
range.  
 

Specifications 
The output waveform must be within the specification range. 
 Eye Amp: Data amplitude ± 5% ± 0.1 V 
 Eye SN: Reference value is 15 or more (phase is 40 to 60%). 
 

Procedures 
1. Insert a 20 dB attenuator into the input terminal of the oscilloscope and connect to the 

DATA OUT terminal of the PPG of the AP9945 with a coaxial cable.  
 
2. Connect the TRIGGER OUT terminal of the PPG of the AP9945 and trigger input 

terminal of the oscilloscope with a coaxial cable.  
 
3. Set up the AP9945 as follows.  

 Data Offset: 0.00 V  Polarity:  Normal 
 Data Cross Point: 50%  Divide Ratio: 1/1 
 Clock Source: Internal  Pattern:  PRBS 
 Bit Rate*: 11.32 Gbit/s Data:  PRBS31 
 Clock Offset: 0.00 V  PPG Trigger: 1/16 
 *:In case of oscillator type, the highest possible frequency setting 

 
4. With the data amplitude, data offset, and data cross point settings of the AP9945 

combined as shown below, check the waveform with the oscilloscope.  
 

Combination A B C D E F 
Data Amplitude 0.5 V 2.0 V 2.0 V 2.0 V 2.0 V 2.0 V 
Data Offset 0 V 0 V -2 V +3 V 0 V 0 V 
Data Cross Point 50% 50% 50% 50% 30% 70% 

 
Connection Diagram 
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(4) Input Sensitivity Test 
Description 

Check that the input sensitivity of the DATA IN of the ED is within the specification range.  
 

Specifications 
The input sensitivity performance must be 0.1 V or more. 
(Since the 20 dB-ATT is inserted into the input, no error must occur for five minutes 
when the Data amplitude is set at 1.0 V or less.) 
 

Procedures 
1. Insert a 20 dB-attenuator into the DATA IN (CDR) terminal of the ED of the AP9945 

and connect to the DATA OUT terminal of the PPG with a coaxial cable.  
 
2. Set up the AP9945 as follows.  

 Data Offset: 0.00 V  Polarity:  Normal 
 Data Cross Point: 50%  Coupling to PPG: Select 
 Clock Source: Internal  Divide Ratio: 1/1 
 Bit Rate*: 11.32 Gbit/s Pattern:  PRBS 
 Clock Offset: 0.00 V  Data:  PRBS31 
 Port Select: DATA IN(CDR) Measure Mode: Single 
 Threshold Level: 0 V  Period:  5 Min 
 *:In case of oscillator type, the highest possible frequency setting 

 
3. Set the AP9945’s data amplitude to a 2.0 V to 0.5 V variable setting and start the 

BER measurement.  
 

Connection Diagram 
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 Performance Test Record Sheet 
 

AP9945 Portable BERT  
Place: Manufacture No.: 
 Tested by: 
Temperature: Approved by: 
Humidity: Date:  

 
 

Results Description of Test 
Min. Actual Max. 

Data Amplitude=0.5 V  BER<0*10-12  (1) BER measurement 
   (CDR)  Data Amplitude=2.0 V  BER<0*10-12  

Data Amplitude=0.5 V  BER<0*10-12  (2) BER measurement 
   (no CDR)  Data Amplitude=2.0 V  BER<0*10-12  
(4) Input sensitivity test    
    

 
 

Description of Test Eye Amp Eye SN 
(3) Output waveform test   
  A) Data Amplitude=0.5 V, Data Offset=0 V, Data Cross Point=50%   
  B) Data Amplitude=2.0 V, Data Offset=0 V, Data Cross Point=50%   
  C) Data Amplitude=2.0 V, Data Offset=-2 V, Data Cross Point=50%   
  D) Data Amplitude=2.0 V, Data Offset=+3 V, Data Cross Point=50%   
  E) Data Amplitude=2.0 V, Data Offset=0 V, Data Cross Point=30%   
  F) Data Amplitude=2.0 V, Data Offset=0 V, Data Cross Point=70%   
   

 
 

Test Conditions  
AP9945 Setting  

Bit rate Gbit/s
Test coding (number of PRBS steps) PRBS31
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5.4 Replacing the Power Fuse 
 
 
 

  
 

● 
● 

 
● 

To prevent fire, use a fuse of the specified rating (for voltage, current, and type). 
Be sure to turn OFF the power switch and disconnect the power cord before 
replacing the fuse.  
Do not short the fuse holder.  

 
Fuse Rating 

The power fuse used by the instrument is as follows.  
•   Maximum rated voltage: 250 V 
•   Maximum rated current: 4 A 
•   Type: time lag 
•   Standard: UL/VDE compliant 
 

Replacing the Fuse  
Perform the following procedure to replace the fuse.  
1. Turn OFF the power switch on the front panel and the main power switch on the rear 

panel.  
2. Remove the power cord from the power connector.  
3. Insert the tips of flathead screw drivers into the indentations on both sides of the fuse 

holder on the rear panel, then push in and pull up to remove the fuse holder.  
4. Remove the blown fuse from the fuse holder.  
5. Insert a new fuse into the fuse holder, then replace the fuse holder into its original 

location.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WARNING
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5.5 Recommended Replacement Parts 
 
 

Yokogawa guarantees this product according to the terms and conditions of the warranty. 
As stated in the warranty, the following wearable parts are not covered under warranty. 
The period of replacement varies according to the conditions of use. The periods in the 
table below are approximate. Contact your nearest YOKOGAWA dealer for replacement 
of parts.  
 

Part Name Recommended Replacement Period 
Cooling fan 6 years 
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6.1 PPG Section  
 
 

Interface 
Item Specifications 

Bit rate 9.95 to 11.32 Gbit/s 
Data format NRZ 
Output level 0.50 to 2.00 Vp-p (in steps of 10 mV) 
TR/TF(20 to 80%) <25ps 
Offset voltage -2 to +3 V (in steps of 10 mv) 
Cross point variation 30 to 70% (in steps of 1%) 
Number of outputs 2 (Non-invert and Invert) 
Connector 3.5 mm-Female 
Output terminating 
conditions 

Either 50 Ω AC-termination or DC-termination can be used. 

Invert function Positive/negative logic invert 

Data output 
(DATA OUT 
 DATA OUT) 

Output control ON/OFF function (GND level at OFF) 
Output level 0.6 Vp-p (AC coupling)  Typ. 
Duty 50% ±10% 
TR/TF(20 to 80 %) <25ps 
Offset voltage -2 to +3 V (in steps of 10 mv) 
Number of outputs 2 (Non-invert and Invert) 
Connector SMA-Female 
Output terminating 
conditions 

Either 50 Ω AC-termination or DC-termination can be used. 

Clock output 
(CLOCK OUT 
 CLOCK OUT) 

Output control ON/OFF function (GND level at OFF) 
Clock trigger 1/16 or 1/64 of the clock frequency 
Pattern trigger PRBS: Outputs a high pulse (128 bit) every 128 cycles of the 

pulse PRBS pattern.  
PROGRAM: Repeatedly outputs Low and High of 1024 bit width 

Low bit rate trigger Clock frequency corresponding to the bit rate pattern  
Output level 0.6 Vp-p ±0.3 V 
Connector SMA-Female 

Trigger output 
(TRIGGER OUT) 

Output terminating 
conditions 

Either 50 Ω AC-termination or DC-termination can be used. 

 
Data 

Item Specifications 
PRBS 2n-1(n=7,15,23,31) 
PROGRAM Select from 2, 4, 8, 16, 32, 64, 128 byte length  

Communication 
pattern 

Low bit rate pattern A pattern of 1/2, 1/4, or 1/8 of the corresponding bit rate (9.95 to 
11.1 Gbit/s)   

SINGLE Adds one bit error each time the button is pressed Error add is  
activated. RATE 1.0E-n (n = 3 to 12, in steps of 1) 
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6.2 ED Section 
 
 

Interface 
Item Specifications 

Bit rate 9.95 to 11.32 Gbit/s 
Bit rate allowable  
range 

Operation bit rate ±100 ppm of the PPG 

Data format NRZ 
Input level 0.1 to 0.7 Vp-p 
Minimum input  
sensitivity 

100 mV or less (for Eye Height)*1 

Input threshold  
variable 

±0.35 V (in steps of 1 mv)  

Connector 3.5 mm-Female 
Input terminating  
conditions 

50 Ω  AC coupling 

Data input*3 
(DATA IN (CDR)) 

Invert function Positive/negative logic invert 
Bit rate 9.95 to 10.71 Gbit/s 
Data format NRZ 
Input level 0.1 to 0.6 Vp-p 
Minimum input  
sensitivity 

100 mV or less (for Eye Height)*1 

Input threshold  
variable 

± 0.3 V (in steps of 1 mv)  

Connector 3.5 mm-Female 
Input terminating  
conditions 

50 Ω AC coupling 

Data input*3 
(DATA IN) 

Invert function Positive/negative logic invert 
Frequency Frequency having the same rate synchronized with the data input 
Input level 0.2 to 0.6 Vp-p 
Connector SMA-Female 

Clock input*3 
(10G CLOCK IN) 

Input terminating  
conditions 

50 Ω  AC coupling 

Clock trigger 1/16 or 1/64 of the clock frequency 
Pattern trigger PRBS: Outputs a high pulse (128 bit) every 128 cycles of the 

pulse PRBS pattern.  
PROGRAM: Repeatedly outputs Low and High of 1024 bit width 

Output level 0.6 Vp-p ±0.3 V 
Connector SMA-Female 

Trigger output 
(TRIGGER OUT) 

Output terminating  
conditions 

Either 50 Ω AC-termination or DC-termination can be used. 

 
Data 

Item Specifications 
PRBS 2n-1(n=7,15,23,31) Receive pattern 
PROGRAM Select from 2, 4, 8, 16, 32, 64, 128 byte length  
Manual Measured between pressing of MEASUREMENT START button 

and pressing of STOP button.  
Single Measured once at the time specified by the user 
Measurement time 99 hours maximum 
Measured results  CURRENT, TIMED, BIT ERROR COUNT, ERROR RATE,  

SYNC LOSS 

Measurement 
function 

Error log Yes 
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6.3 Common Items 
 
 

Item Specifications 
Operation clock mode Internal clock, external reference clock, external clock 

Internal fixed  
frequency 
(when oscillator  
specified) 

Select 1 or 2 frequencies from 9.95328 GHz, 10.3125 GHz, 
10.6642 GHz, 10.709 GHz, 11.095 GHz.  

Internal clock 

Internal variable  
frequency 
(when SG specified)

Variable frequency range: 9.95 to 11.32 GHz 
Set resolution: 1 kHz 
Frequency accuracy: ± 3 ppm 

Frequency 1/16 or 1/64 of bit rate 
Input level 0.4 to 1.0 Vp-p 
Duty 50%-square waveform (nominal value) 
Connector SMA-Female 

External reference  
clock*3 
(REF CLOCK IN) 

Input terminating  
conditions 

50 Ω  AC coupling 

Frequency 1/1 of bit rate 
Input level 0.4 to 1.0 Vp-p 
Duty 50% (nominal value) 
Connector SMA-Female 

External clock  
input*3 
(10 G CLOCK IN) 

Input terminating  
conditions 

50 Ω  AC coupling 

USB USB1.1, USB2.0 Main unit control  
IF 
(USB) 

Port setting Communication speed: 9600 bps, data bit: 8, parity: none,  
stop bit: 1, flow control: none 
(connect the USB IF of the PC) 
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6.4 General Specifications 
 
 

Item Specifications 
Rated supply voltage 100 to 240 VAC 
Allowed supply voltage 
fluctuation range 

90 to 264 VAC 

Rated supply voltage  
frequency 

50/60 Hz 

Power supply  
frequency variation  
range 

48 to 63 Hz 

Power supply 

Maximum power  
consumption 

100 VA or less 

Dimensions W 213 × H 88 × D 429 [mm] (not including protrusions) Dimensions and 
weight Weight 5 kg or less 

Temperature range 5 to 40°C  Operating 
Environment Humidity range 20 to 80% 
Safety standard Supported standards  EN61010-1  

• Overvoltage category (Installation category) CAT II*2 
• Measurement category CAT I*3 
• Pollution degree 2*4 

Supported standards  EN61326 Class A 
EN55011 Class A 

Emission 

Cable conditions • USB 
 Use a shielded cable.  
 Use a cable of three meters or less in length.  
• DATA OUT/DATA IN (CDR) 
 Use a coaxial cable of three meters in length or less.  
• CLOCK OUT, DATA IN, 10G CLOCK IN, TRIGGER OUT 
 Use a coaxial cable of three meters in length or less.  

Complying standard EN61326 Annex A Immunity 
Cable conditions Same as emission cable conditions 

 
*1: Specified by making loop back measurements in the PPG and ED with PRBS31 and data cross point of 50%. 
*2: The Overvoltage Category is a value used to define the transient overvoltage condition and includes the 

impulse withstand voltage regulation. CAT II applies to electrical equipment that is powered through a fixed 
installation such as a wall outlet wired to a distribution board. 

*3: This equipment is for Measurement Category I (CAT I). Do not use it with Measurement Category II (CAT 
II),Measurement Category III (CAT III), nor Measurement Category IV (CAT IV). 
CAT I applies to electrical equipment on a circuit that is not connected directly to the power source and 
measurement performed on such wiring. CAT II applies to electrical equipment that is powered through a fixed 
installation such as a wall outlet wired to a distribution board and measurement performed on such wiring. CAT 
III applies to measurement of the distribution level, that is, building wiring, fixed installations. CAT IV applies to 
measurement of the primary supply level, that is, overhead lines, cable systems, and so on. 

*4: Pollution Degree applies to the degree of adhesion of a solid, liquid, or gas which deteriorates withstand voltage 
or surface resistivity. Pollution Degree 2 applies to normal indoor atmospheres (with only non-conductive 
pollution). 
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6.5 External Dimensions 
 

 
       UNIT: mm 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Actual dimensions may vary by +/-3% 
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Appendix 1 Pseudo Random Pattern 
   (PRBS Pattern) 
 

Principles of Pseudo Random Pattern Generation 
The pseudo random pattern is expressed by the N-th generating polynomial expression 
shown in the Table below. The cycle is “2N-1”. In the PRBS pattern having a cycle of “2N-1”, 
the pattern in which “1” is continued N bits is generated only once.  
 
For the output level of the PRBS pattern, “1” and “0” correspond to the Low level and 
High level respectively when Polarity and Invert are set.  
 
The mark ratio of the PRBS pattern of this instrument is fixed at “1/2”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  N : Shift register,  : Exclusive OR 
 
 
 
 
 
        

Cycle Generating Polynomial
Expression

Output1 2 3 4

Output1 2 3

27 - 1

13 14 15

215 - 1 1 + X14+ X15

1 + X6 + X7

5 6 7

Output1 2 3 20 21 22 23

223 - 1

231 - 1

17 18

1 + X18+ X23

1 + X28+ X31

1 30 31 Output

Pattern Generation Block

27 28 292 3

19
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Appendix 2 Auto Sync Function 
 
 

Auto Sync Function 
In this instrument, the pattern is synchronized by the PRBS pattern or program pattern. This 
instrument provides an auto sync function that compares the input pattern with the reference 
pattern to automatically establish the pattern synchronization.  
 

Synchronization Establishment/Sync Loss Conditions 
Whether or not the synchronization is established is judged based on the threshold 
value conditions for the pattern synchronization.  
If the error rate exceeds the threshold value of the sync loss conditions, it is judged as sync 
loss status. Additionally, if the error rate equals the threshold value of the synchronization 
establishment conditions or less, synchronization is judged to be established.  
Furthermore, when the error rate always exceeds the threshold value of the sync loss 
conditions, the pattern cannot be synchronized.  
The pattern synchronization threshold value conditions for this instrument are as 
follows.  
 

Sync loss conditions Synchronization establishment 
conditions 

Pattern 

Measure 
Bit 

Error Bit Error 
Rate 

Measure 
Bit 

Error Bit Error 
Rate 

PRBS 8,192 2,048 2.50E-01 128 2 1.56E-02
PROGRAM 16,384 128 7.81E-03 16,384 32 1.95E-03
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Appendix 3 PRBS Pattern Synchronization 
Method 

 
Block Diagram 

The following shows the block diagram of the PRBS pattern synchronization method for 
this instrument.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A side / B side auto switching 
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Appendix 4 Program Pattern Synchronization 
Method 

 
Block Diagram 

The following shows the block diagram of the Program pattern synchronization method 
for this instrument.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Synchronization Method 
The reference pattern is compared with the received pattern. If these patterns do not match, 
the pattern is shifted one bit and it is compared with the reference pattern again. This bit shift 
is performed repeatedly until the receive pattern matches the reference pattern in order to 
establish the synchronization. 
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・
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1 bit

2 bits

N bits

If not matched, the recieved
pattern is shifted one more bit,
then compared with the
reference pattern again.

If not matched, the recieved
pattern is shifted one more bit,
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reference pattern again.

If not matched, the recieved
pattern is shifted one bit, then
compared with the reference
pattern.
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